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Dongle 

 

 

    

 

 A dongle is a small USB connector that plugs into a USB port on your computer.  

For many ProSail machines, a dongle is required for the software to run. 

Licence Agreement 

This is a legal agreement between you, the end user, and Armstrong-White 

Automation (NZ) Ltd.  This software is owned exclusively by Armstrong-White 

Automation (NZ) Ltd.  Armstrong-White Automation (NZ) Ltd grants you the 

right to use this software by way of this licence agreement.  It is important to 

note that if you loose the software, it will be replaced free of charge.  However, 

if you loose the dongle (or serial converter) which protects this software, you 

have lost your entire software licence.  Hence it is recommended that the dongle 

(or serial converter) be insured for the full replacement cost of this software 

licence.  If however the dongle (or serial converter) is only damaged, it will be 

replaced in exchange for the damaged one for no more than the material cost. 

Disclaimer 

 Armstrong-White Automation (NZ) Ltd is not liable or responsible to the 

purchaser or user for loss or damage caused, or alleged to be caused, directly or 

indirectly by the software or hardware and its attendant documention, including 

(but not limited to) interruption of service, loss of business, or anticipatory 

profits. 

USB to Serial converter 

 

    

 

    

 

  With the ProSail plotter mkIII or the ProSail digitiser, the dongle is an optional 

extra and is not supplied as standard.  With these machines the software will 

run so long as the USB cable from the “USB to Serial converter” is plugged into 

the computer (the machine does not need to be turned on, just the USB cable 

plugged in to the computer). 
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Introduction 

ProSail Spinnakr is a moulded spinnaker program.  Although a mould has the advantages of 

producing a fair shape and is easily scalable, it is important to note in the case of spinnakers 

that the flying shape will differ from the 3D view on the screen.   This is a result of the fact that 

spinnakers are only attached at 3 points and in particular the spinnaker pole can be raised or 

lowered.  As a general rule the flying spinnaker will have significantly higher 

shoulders than the spinnaker on the screen.   This is a result of the spinnaker being 

lifted by the low air pressure above the spinnaker.  Similarly the cross-sectional 

chord shapes will be flatter on the flying spinnaker than they appear on the screen 

due to the low pressure around the sides of the spinnaker.    

Because of this, the spinnaker on the screen should have lower shoulders and fuller 

chords.  If this is not done, the head will crease.   

Although the 3D view will appear different, the conventional Folded (Flattened) view 

of the spinnaker will be the same.  Hence the Flattened facility can be used to 

compare mould designs with your current floor designs. 

Designing a Spinnaker comprises three main steps: 

 

1) Generate a Mould : 

 (i)   Dimensions from the Mould menu : Specify luff, foot, girths etc. 

 (ii)  Chords from the Mould menu : Specify the cross-sectional (chord) shapes of 

 the mould at the head, mid-section and foot. 

 (iii) Shaping from the Mould menu : Specify the lower part of the centre seam. 

 

2) Generate Panels over the Mould : 

 (i)   New or Open from the Panel menu : Specify the panel layout. 

 (ii)  Patches from the Window menu. 

 (iii) Colour Panels from the Window menu.  Colour the panels to identify fabric. 

 

3) Production : 

 Send the panels to the Nesting window for nesting and driving a plotter or cutter. 
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Units 

Selecting Units from the File menu : 

This dialogue determines the current units and decimal places displayed in all of the dialogues 

throughout the program. 

Although numbers will be displayed in these units they can be entered in any of the above 

units.  For example if you want to enter 1.5 feet into a dialogue, you can enter 1.5f or 1.5’ or 

1f6i or 1’6”.   Then after pressing the Enter key it will be converted to the current units you 

selected in the Units dialogue. e.g. 457.2mm 

If the current field is already displayed in the units that you want then when you enter a new 

number there is no need to add the units letters after the number.  Just type the number. 

Most dialogues have a % button that toggles between % and the current unit when you click in 

it. 

If for example mm is displayed in the % button then fields in the dialogue will be displayed in 

mm. 

If however %  is displayed in the % button then some fields will be displayed as a %.  Then if 

you enter a number into these fields it will be assumed to be a % unless you add the units 

letters to the end of the number. 

Some examples 

   entered   converted 

   4.2f    1280.2mm 

   1.4m    1400.0mm 

   4.2f - 7mm  1273.2mm 

   10i    254mm 

   100+10.7   110.7mm 
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You can view your spinnaker as a 3D “wire frame” or as a “solid rendering”.  

To switch between wire frame and solid rendering click the icon on the left of the screen. 

Viewing 

The view direction can be changed by dragging any of the 3 scroll bars around. 

An easier way to change the view direction is with the Animate feature.  Select Animate from 

the View menu (or click the “F1” key on the keyboard, or right click the mouse and click on 

Animate.  A square outline will appear on the screen.  As soon as the mouse enters the square 

the animate feature is activated.  By moving the mouse from side to side and up or down you 

can rotate the view. 

Clicking the small square at the bottom left of the screen will show the plan view. 

There are two animation modes when moving the mouse horizontally.  It will either rotate the 

view in a horizontal plane or it will tilt the view clockwise/anticlockwise.  To toggle between 

these 2 modes, press and release the Ctrl key on the keyboard while animating.   This will 

redisplay the square outline.  After moving the mouse into this square again, the mode will 

have changed.  

To deactivate animation, click the mouse anywhere on the screen. 
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Light from :  Click on this to animate the direction of the light source.   Works in a 

similar way to animating the view except it displays 2 arrows indicating 

the direction of the light source.  The arrows are largest when pointing 

directly into the screen and change colour when at 90 degrees to this 

direction. 

 There are actually 2 light sources - one directly in front which is fixed 

and another one that you can change the direction of using Light 

from. 

toolbox :  Displays the lighting toolbox.  See next page. 

View1, View1, View3, View4, View5 : Click on one of these to go to that stored 

view.  A quicker way is to use the “F2” key on the keyboard to loop 

through the different views you have stored.  

Store View :  Up to 5 different views including different light settings for each can be 

stored.  Click Store View and select one of the 5 views to store the 

current view. 

The maximum rotation of the view (either 180 or 360 degrees) is set in preferences from the 

File menu : scroll bars 360 degrees. 

Right clicking the mouse on 

the screen will display this 

popup menu : 

Displays the surface mould with minimal number of lines. 

Displays the surface mould with a large number of lines. 

Displays the panels that have been generated. 

Displays the panels that have been generated showing development lines. 

Viewing 
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Ambient:  Changes the intensity of ambient light. 

Transparent:  Changes the level of transparency of the surface. 

Color:  Changes surface color. 

Back:  Changes the background color. 

Default Light: Changes color, light direction, ambient and transparent to the 

default values. 

Zoom view 

To zoom into part of the surface, hold down the Ctrl key on the keyboard and with it still 

held down press and release the Z key on the keyboard.   Then release the Ctrl key.  A 

horizontal and vertical line will be displayed at the mouse location.  Move the mouse to 

the area you want to zoom in on.  Click and hold down the left mouse button and drag the 

resulting selection box to encompass the area you want zoomed.  When the mouse button 

is released, the selection box will be zoomed to fill the entire window.   

If viewing the surface as a solid render, you are able to animate the view while it is 

zoomed.  The point on the surface at the centre of the window will remain at the centre as 

you animate. 

To unzoom, click on any of these icons :  

 

Note: there are two modes when dragging the selection box.  Either the click of the mouse 

will correspond to one corner of the selection box or the click will correspond to the centre 

of the selection box.  To swap between these two modes, press and release the Ctrl key 

while the selection box is visible. 

Toolbox 

Viewing 
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Dimensions 

Select Dimensions from the Mould menu. 

Luff  Luff length around the sail.  

Head-Luff  Location of the mid-girth measured as a % down the luff. 

Mid. Girth  Girth measured around the mid-chord at the Head-luff location.  This is a 

close approximation to the girth measured on the flattened sail. 

Foot Girth  Girth measured around the foot-chord.  This is a close approximation to the 

girth measured on the flattened sail so long as Foot Rotation is small. 

Lower Girth  ProSail Spinnakr will generate two different types of spinnakers depending 

upon whether Lower Girth is ticked :  

 (i)  If Lower Girth is ticked, you can specify a girth measured mid-way 

between the foot and the mid-section.  This is often used for Dinghy sails 

where this girth can be greater than the Mid. Girth.  Girths throughout the 

sail will change in a smooth way between the three girth points and the head.   

 (ii) If Lower Girth is not ticked,  the girths throughout the sail will change in 

a smooth way from the foot to a maximum value (which can be the same as 

the foot) at the Mid. Girth then reduce to the head.  This is used for IMS/IOR 

type spinnakers.   

Chord Sectors  This determines how many arc sections are used to define the shape of the 

chords.   See Chords chapter.   It is recommended that only 2 be used for 

ease of use. 
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Dimensions 

Head Entry  Projected angle of the flying head as seen from high above the flying sail (see 

diagram above).  The actual head angle measured on the floor by flattening 

the head will be less than the Head Entry (e.g. to achieve a head angle of 

110 degrees you may need to enter a Head Entry of 120 or more).  The 

actual head angle is displayed in the lower left corner of the screen when the 

sail is re-scaled.  i.e. after selecting ok to the Dimensions dialogue.    (The 

vertical girth up the centre seam of the sail is also displayed after rescaling in 

the lower left corner of the screen.  See Girth chapter.)  As well as 

determining the actual head angle, the Head Entry will also determine the 

entry angle for the mid and head chords.   See Chords chapter. 

Head Rotation  This increases the entry angle of the mid and head chords in the sail.   If set 

at zero, the entry angle of these chords will be 90 degrees to the luff as seen 

from an aerial view (see diagram above).  Head Rotation has the effect of 

increasing the amount of shape in the flattened view of the sail (see Flatten 

chapter) without increasing the actual head angle.  It also has the effect of 

reducing the luff round on the luff head panel.   If set at zero the luff head 

panel will be almost symmetrical.   Increasing Head Rotation will reduce the 

amount of round on the luff.   Increasing Head Rotation further will introduce 

hollow on the luff.   This hollowing effect is greater the narrower the head 

panels are. 

Foot Entry  This is similar to the Head Entry and is the projected angle of the flying foot as 

seen from high above the flying sail (see diagram above).  This determines the 

entry angle of the foot chord.  See Chords chapter. 

Aerial View 
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Dimensions 

Head Control  This is very important and controls how flat the head is.  Increasing Head 

Control will increase the fullness in the head.   It is very important not to 

make Head Control too large.   Remember that the flying sail will lift and so 

the picture on the screen should have significantly lower shoulders than the 

flying shape.  A typical value is 55%.   Larger values may result in the head 

folding.   If in doubt specify a lower Head Control. 

Foot Rotation  During panel development, fabric is laid over the mould.   The foot round (as 

specified in the Shaping window) is added to the bottom of the foot panel.   As 

a result, the bottom of the foot panel will lay off the end of the mould.   This is 

not a problem but if you want to have control of the mould close to where the 

foot will eventually lay, you can rotate the mould at the foot with Foot 

Rotation (see diagram above).  However please note that increasing Foot 

Rotation does not generate more foot round.   It only rotates the foot of the 

mould.   The foot round specified in the Shaping window determines the 

amount of foot round.   Also making Foot Rotation too large can reduce the 

accuracy of the generated Foot Girth.   Its best to keep Foot Rotation small.   

A typical value is 5 degrees. 

Foot Control  This is not a very important variable.  It determines how the entry angle of the 

cross-sections vary over the lower half of the sail.  At the mid section the 

entry angle will be defined by Head Entry and Head Rotation.  At the foot it 

will be defined by Foot Entry.   However between the mid-section and the 

foot it will gradually change.  Foot Control influences the way in which it 

changes.   The smaller the value for Foot Control the greater the influence of 

the Foot Entry angle on the intermediate sections. 

% Head Control = Head Control / upper 
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Chords 

Select Chords from the Mould menu. 

Click on this picture at the head, mid-section or foot to display the chords 

at those three locations. 

The following window determines the cross-sections (chords) at the head, mid-section and foot.  

Between these sections the cross-sectional shape will vary in a fair manner up the sail.  

Although the head has zero width, the head-section shape influences the cross-sectional shape 

between the mid-section and the head. 

Aerial view 

mid-chord 

head-chord 

foot-chord 
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Chords 

As well as the girths and entry angles which are defined by the Dimensions dialogue, the 

shape of each chord can be further defined using arcs.   The number of arcs is determined by 

Chord Sectors in the Dimensions dialogue.   If Chord Sectors is set at 2 (recommended) 

the follow geometry defines a chord (half of a chord for symmetry) made up of 2 arcs : 

Before entering the Chord window, some of the dimensions entered in the Dimensions 

dialogue already partially define the shape of the chords.   For the mid-chord, the girth is equal 

to Mid. Girth.   The entry angle of the chord is equal to the Head Rotation + half the Head 

Entry : 

For the foot-chord, the girth is equal to the Foot Girth.    The entry angle is equal to half the 

Foot Entry : 

In the case of the head-chord, the entry angle is the same as the mid-chord except  the girth is 

of course equal to zero.  Although its girth is zero, the shape of the head-chord influences the 

area between the mid-chord and the head. 
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Chords 

length defines the % of the chord girth each arc covers.   In this case the inner arc 

covers 60% of the chord girth and the outer arc covers 40%. 

radius defines the radius of the outer arc as a % of the radius of the inner arc.  (The 

inner arc has a percentage value of 100% by definition.  The physical value of the 

inner arc is determined by the program to achieve the specified entry angle.)  In this 

case the radius of the outer arc is 50% of the inner arc radius.   The smaller the 

outer radius, the flatter the chord will be. 

The cross-sectional shape of the flying sail will flatten as the shoulders are pulled outward when 

flying.  Hence it is important not to make the mid-chord too flat on the computer otherwise it 

will not be able to be supported by the airflow and the sail will fold.  Typical values for the mid-

chords outer radius is 50 - 100%.  If in doubt use 100%. 

Unlike the mid-chord, the head-chord needs to be flattened to prevent too much 

shape in the top of the radial head panels.   A typical value for the head-chords outer 

radius is 20%.   Making this value too large can result in the top of the head creasing. 

The foot-chord is usually quite round with an outer radius at least the same as the mid-chord. 

To produce a fair sail it is recommended that the length values for each arc are kept similar for 

all three chords.  e.g. if the length values for the mid-chord are 60% and 40%, use similar 

values for the foot-chord and head-chord. 

If more than 2 arcs are required to define the 

chord shape, then select 3 Chord Sectors in the 

Dimensions dialogue.  This gives you more 

control but makes shaping more complex.  Very 

few people use 3 arcs. 

The depth button displays the amount of %Depth in the chord.  %Depth = Depth / 

Luff to leech;   see diagram on previous page.  If you wish to specify the %Depth 

of a chord, click on the depth button and type in the required depth.   After 

selecting Ok, the outer radius of the chord will have changed (if it is possible) to 

achieve the desired depth.  
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Shaping 

Select Shaping from the Mould menu. 

This window operates in exactly the same way as the shaping window in the headsail/mainsail 

program. 

Displays the lower part of the 3D view of the centre seam from the mid-section on 

the left to the foot on the right : 

As with the Depth curve in the headsail/mainsail program, the more curvature there 

is in this curve, the more shape there will be in the panels in that region.  Making 

this curve fuller will have the effect of pushing the foot aft and hence increasing the 

amount of shape in all the panels in the lower half of the sail. 

Please note however that it is not a good idea to make the foot end of this curve 

bend down sharply.   If a highly shaped panel is required here, it should be done 

with PanelMaker or by hand. 
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Shaping 

Displays half of the foot round (symmetry is used) : 

This shape is added to the bottom of the foot panel after panel development.   See 

the note on Foot Rotation in the Dimensions chapter. 
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Flatten 

Select Flatten from the Window menu or click the Flatten button in the Dimensions, 

Chords or Shaping dialogues. 

This outline is the conventional flattened spinnaker (that most people are familiar with) 

produced by folding the spinnaker down the centre seam and pinning it out as flat as possible 

on the floor.  This is similar to the Flattened method in the ProSail (headsail/mainsail) program 

except of course it only looks at half the sail. 

The top curve is the centre seam, the bottom curve is the luff/leech.  The intermediate 

hollowed curve is the fanned leech you would get if you were to tension just the leech of the 

spinnaker.   i.e. The same as the fanned method used in the headsail/mainsail program. 

The maximum amount of shape on the centre fold versus the maximum amount of shape on 

the leech is very important.   Most people want a ratio of 2 : 1 or more.  The higher the ratio 

the more highly shaped the sail is and the more stable it is. 

One way to increase the amount of shape on the centre fold (and reduce it on the leech) is to 

go to the Shaping window and increase the shaping curve using the scale option.  This will 

increase the amount of shape in the panels below the mid-section.  However the more this 

curve is increased, the more hollow there will be on the leech radial-clew panel which may 

cause problems with panel development (see headsail/mainsail manual). 

Another way to increase the ratio is to make the mid-chord fuller (i.e. increase the outer  

radius).  This also has the effect of reducing the amount of fanned hollow on the leech. 

Another way to increase the ratio is to specify a Head Rotation in the Dimensions dialogue.  

This essentially takes the flattened view of the sail and rotates the head clockwise.   It also has 

the effect of reducing the amount of round on the leech head-panel.  In fact Head Rotation 

can be increased to the point that the leech head-panel will have hollow on the leech.  Typically 

most people specify around 10 degrees or more. 
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Select Girths from the Window menu. 

Enter the desired location down the leech.   This will calculate the shortest distance from 

this leech location to the centre seam.  This will be half the girth across the sail at that 

location.  To generate a girth from a leech location to a location down the centre seam, tick 

down centre and enter a value. 

After selecting OK the path will be drawn on the screen with its girth : 

The vertical girth up the entire centre seam of the sail is calculated by Spinnakr.   It is 

displayed in the lower left corner of the screen (next to the actual head angle) after the sail 

is re-scaled.  i.e. after selecting OK to the dimensions dialogue or after panels have been 

developed on the sail.   If panels have been developed, this girth will include the foot 

round.   If panels have not been developed, it will only make an approximation of the foot 

round needed (since the foot panel determines the exact location of the foot). 

Vertical Girth : 

Girths 
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Panel Development 

To develop the current sail into panels, either select New from the Panel menu to create a 

new panel layout or select Open from the Panel menu to use an existing panel layout.  If New 

is selected, the following Panel Layout dialogue will appear : 

Double click on the layout you want. 

The Turnover dialogue will appear next : 

Specify the extra seam allowances you want around the sail for turnovers.  These 

seams are added to the sail dimensions entered in the Dimensions dialogue.  If you 

don’t want any, just set everything to zero.  Butt is the seam required down the centre 

seam. 
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Panel Development 

Cross-cut 

With these panel configurations, the panels are generated in the same way 

as above but are rotated so they are at 90 degrees to the leech. 

These panels are developed from the bottom of the sail up to the head.  Since this is the 

opposite direction from normal, the panels are shaped on their bottom edge and straight 

on the top. 

In the tri-radial panel configuration, the horizontal panels are developed in the 

conventional direction, and hence are shaped on the top edge and straight on the 

bottom. 

These horizontal panels are also shaped on the top edge and straight on the bottom.  

To generate these panels, the following dialogue is displayed where you specify the 

number of panels required and ratio.  Ratio is equal to the width of the foot panel 

divided by the width of the top horizontal panel.   This is the preferred panel layout 

to take through to PatternMaker if using PatternMaker. 
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Horizontal Interface 

When a panel configuration requires a horizontal interface 

seam, the following dialogue will appear.  Luff is the 

distance down from the head that the seam will intersect 

the luff and leech. 

Radial-Head 

All radial-head panels are shaped on both sides.   They are however not symmetrical and 

are of different lengths.   The radial head dialogue operates the same as for headsails and 

mainsails except it only displays half of the head panels.    

Panel Development 
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Panel Development 

Panels are developed based on Number and ratio.  They are developed from the leech to 

the centre where ratio determines how the edge width of the panels change : 

ratio = luff / leech as a % 

leech : Edge width of the leech panel.   This does not 

include the seam allowance or shaping. 

luff : Edge width of the centre panel.   This does not 

include the seam allowance or shaping. 

NOTE : Fabric Width is not used to generate the panel size since panel size is totally 

defined by Number and ratio.  However it is used after the panel has been generated as 

a test to see if the panel has exceeded this size.  If it has, a warning message will be 

displayed. 

Angle Limit is similar to Fabric Width in that it is only a test to see if the angle of the 

panel (measured near the head) has exceeded this angle.  This is useful for some fabrics 

where you might not want to exceed say 6 degrees for example.  If you are not worried 

about angle, specify a large value. e.g. 30. 

The panels will be orientated on the fabric so one side will be parallel with the 

fabric.   This will correspond to the leech side of the spinnaker.  This will 

produce the most efficient use of the fabric. 

The panels will be orientated on the fabric so the centre of the panel will be 

parallel with the fabric.  This is the common orientation but is very wasteful on 

fabric. 

Orientation defines the orientation of all the head panels on the fabric : 
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Panel Development 

Ratio is useful for smoothly changing panel widths.   However when a sudden change in panel 

width is required, tick reduce : 

Reduce splits the head panels into regions.  The value specified for reduce is the length of the 

region either as a % of the horizontal interface seam or in absolute length.  As well as 

specifying a value for reduce, you can also click on the end of this reducing line and drag it to 

the required location along the horizontal interface.  

Within this region the panels are defined using Number and ratio.  Once this region has been 

generated the radial head dialogue will be displayed again for the remainder of the head.   If 

desired this can be split again using reduce. 
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Panel Development 

Radial-Clew 

To make these panel seams line up with the seams above, use the same Number and 

ratio as the panels above. 

Radial-Clew panels are specified in a similar way to Radial-Head panels except in two 

sections.  The first section defines the panels that touch the horizontal interface seam. 

If selected, panels will be generated right to the end. 

If selected, panels will stop short of the end.  This allows the next panel to straddle 

the corner.  This is commonly used if the next panels are to be made to the full 

fabric width. 

end If zero, the panels will all terminate at the clew.  If non-zero, the clew end of the 

panels will have a width equal to this value (excluding the seam width).  i.e. they 

will radiate along the foot. 
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The next section defines the clew panels that touch the centre seam : 

If selected, panels are developed so their edge width is defined by Number and 

ratio as described previously. 

If selected, panels are developed to either their full Fabric Width or to their full 

Angle Limit whichever is the most limiting.  If angle is not important, specify a 

large Angle Limit.  

Panel Development 
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Mid-Vertical panels 

Vertical panels in the middle of the sail are specified using two sets of Number and 

ratio : 

The top set define the seams on the upper interface.  The bottom set define the seams on 

the lower interface. 

ratio = luff / leech as a % 

ratio = luff / leech as a % 

Panel Development 
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Panel Preferences 

Select Preferences from the Panel menu : 

If Seam on both sides is ticked, the seam can be joined as follows where the Seam 

Width entered in the panel dialogues is 1.5 times the the size of the overlap : 

If Seam on both sides is not ticked, the overlap is simply the Seam Width : 

Panel Development 
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The offset numbers correspond to 0, 25, 50, 75 and 100% locations. 

To specify the way the panel offsets are displayed, click on the Pref button to display the 

following : 

Select Panels from the Window menu. 

View Panels 

Loops through 

all the panels. 

Visually exaggerates panel curves for ease of viewing. 

Offsets are measured up from a flat line between the ends.  Most common. 

Does not include seam allowance. 

Offsets are NOT measured up from a flat line between the ends.   They are 

measured down from the maximum depth point on the curve.  The following 

2 icons determine whether this includes the seam allowance : 

Includes seam allowance. 

For head panels the following icons define how the offsets are displayed : 

From Fabric edge 

From line corresponding to zero shape. 

From centre 
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You can either select a colour by clicking in one of the boxes under the heading Basic Colors 

or under the heading Custom Colors.  Click Ok to leave the dialogue.  Or you can define (and 

store) your own custom colours. 

To define your own custom colours : 

1) First click in one of the empty boxes under the heading Custom Colors.  This is where 

your custom colour will be stored.  It is important to click here before defining the colour 

otherwise it will by default be stored in the first location which might overwrite one of 

your previously stored colours.  Very annoying. 

2) Then click the closest colour to the colour you want in one of the colours under the 

heading Basic Colors.  Alternatively you can click on the large rainbow coloured square 

in the right half of the dialogue. 

3) You can then modify the colour using the controls on the right half of the dialogue.   The 

far right vertical scroll bar is useful for specifying luminosity (intensity).  Red, Green, Blue 

give the relative mix of each of these colours that creates the resulting colour.  These 

vary between 0 and 255 and you can enter them directly if you wish.  The colour black 

corresponds to Red, Green, Blue all being 0.   White corresponds to them all being 255.   

4) Once you are happy with your colour, click on Add Custom Colors to add this colour to 

the original position you selected at point 1).  Click Ok to leave the dialogue. 

Select Colour Panels from the Window menu: 

Click on the large New Colour button to display the following : 

Colour Panels 
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To make a panel the same colour as the New Colour button (current colour), simply click in 

that panel.   Do this for all the panels you want to make that colour.   You can also click (and 

with the mouse button still down) drag a selection rectangle across multiple panels.  All the 

panels that intersect that rectangle will become that colour. 

To make all the panels the current colour click the make all button. 

To make the current colour the same colour as one of the panels, first click the Copy Colour 

button and then click on that panel. 

At any stage if you make a mistake you can click the Undo button.  Undo can be used as many 

times as required. 

Colour Panels 
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After developing panels you can define patches (if this module is present) by selecting Patches 

from the Window menu.  This will display a picture of the sail in the left half of the window 

with its panels and any patches it may have. 

The right half of the window shows the current corner of the sail we are looking at (namely 

head or clew).   To look at another corner of the sail click the mouse near that corner in the 

picture of the sail.   

The name of the corner and the number of patches it has will be displayed at the centre top of 

the window.  In the example below we are looking at the Clew Patches and there are 2 of 

them :  

The first time you 

enter this dialogue 

there will be no picture 

to the right.  Namely 

no patches.  To specify 

clew patches, click on a 

number next to Clew 

Patches.   

Patches (Extra module) 

Clew Patches : Number of clew patches.  They are all the same shape but different sizes. 

foot : Distance along the foot of the 1st (largest) patch. 

leech : Distance along the leech of the 1st (largest) patch. 

Radius :  For the head, a radius is specified rather than foot and leech. 

curved : Ticked if the patches are curved. 

Orientate :  Specifies the fabric orientation of the patches used when nesting.  If you 

are not happy with leech orientation, you can select other.  If other is 

selected, a small lever will appear with a control point on the end of it.  

This control point can be dragged with the mouse to define the thread line 

direction. 

Control points : Specifies the number of small red control points the 1st patch has around 

it.  These points can be dragged with the mouse.  If curved is ticked, 

these control points will not lay on the patch but will influence it.  The 

more points, the more control you have over the shape of the patch 

however the more difficult it is to produce a nice looking shape. 



32 ProSail 

Clicking one of these buttons will display the following 

dialogue for the corresponding patch number : 
...... 

number : Number of strips in that patch. 

overlap : The overlap seam on the perimeter of 

the patch. 

Eyelet radius : How far from the corner of the sail the 

centreline of the strips will pass. 

taper : % of seam taper.  0% means the strips 

will be parallel.  100% means the strips 

will narrow at the corner of the sail to a 

width equal to twice the Eyelet radius. 

1) If fan is selected the following information can be specified : 

2) If plain is selected the patch will be made from one piece of fabric. 

3) If radial is selected the patch will be made up of radial strips which exactly lay on top of 

the radial panels in that corner.   This option is only available if you also have the 

PanelMaker module. 

To define the other patches for that sail corner click on the corresponding button : 1st, 2nd 

etc.  Each patch can be defined differently.  For example a plain patch can be placed over a fan 

patch. 

To the right of the patches corresponding button will be a %.  This is the size of the patch as a 

% of the size of the 1st patch. 

The information defining patches is saved in the Patch files.  These files are handled using the 

Open, Save and Save As menu items under the File menu in this patch screen.  Note : 

Patches are not saved with the sail mould.  Like panel files, panel layout files and fabric files, 

they are saved separately from the mould.  The advantage being you can load patch files 

generated on one mould for use on another mould.  They will of course be slightly different 

since they need to adjust for the change in angles from one sail to another. 

Patches (Extra module) 
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Enter the desired fabric width to be used.   See the PanelMaker & Nesting manual for details. 

Nesting 

After developing panels, select Nesting from the Window menu to take the panels to the 

nesting window. 

Click New panels to take the developed panels to the nesting window.  If you click No, the 

panels on the nesting window (if any) will not change. 

If the sail has patches, tick Generate Patches to have these patches added to the end of the 

nested panels. 

If any patches are of the Plain patch type, click on warp or fill to select which way you want 

the panels orientated on the cloth. 

If Mark base patches is ticked, the largest Plain patch in each corner of the sail will have the 

location of its smaller patches marked on it.  This can help in sewing the different layers of 

patches together. 

IMPORTANT : If go back to the 3D viewing window and redevelop panels, you have to select 

Nesting from the Window menu again to load these new panels on to the nesting screen.   If 

you just click on the nesting window to bring it to the front, it will still have the previous panels 

on it. 
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File 

 New  : Create a new Spinnaker mould file. 

 Open Ctrl O : Open an existing mould file. 

 Save Ctrl S : Save the changes made to the current mould. 

 Save As.  : Save the current mould with a new name. 

 Units  : Displays the Units Preferences dialogue. 

 …………… 

 Zoom Ctrl Z : Zoom in. 

 …………… 

 Preferences  : Displays the general preferences dialogue. 

 ...............  

 Quit Ctrl Q : Leave Spinnakr. 

 

Mould 

 Shaping Ctrl F : Displays the Shaping window. 

 Chords Ctrl C : Displays the Chord window. 

 Dimensions Ctrl D : Displays the Dimensions dialogue. 

 ...............  

 Rescale Ctrl R : Force Spinnakr to rescale the mould. 

 Area  : Calculates the sail area around the mould including the foot 
round. 

Panel 

 New Ctrl P : Display the Panel Layout dialogue for developing panels. 

 Open Ctrl W : Open a previously saved Panel Layout and develop panels. 

 Save  : Save the current panel Layout. 

 Save As.  : Save the current Panel Layout with a new name. 

 ...............  

 Preferences  : Display the Panel Preferences dialogue. 

 Show numbers : Show or Hide panel numbering on the panels.  

 

Window 

 Flatten Ctrl C : Display the flattened spinnaker window. 

 Girths Ctrl G : Enter the Girths window. 

 Panels Ctrl A : Display the panel window. 

 Patches  : Display the Patches window. 

 Colour Panels  : Enter the Panel Colouring window. 

 PatternMaker  : Display the PatternMaker window. 

 Nesting Ctrl N : Enter the Nesting window. 

 

Menus 
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View  

 Animate F1 : Animate view. 

 ...............  

 Toolbox  : Display lighting toolbox 

 Light from  : Change light direction 

 Next view F2 : Loop through stored views. 

 Show scrolls  : Show or Hide the viewing scroll bars 

 

Print  

 Dimensions  : Display the spinnaker dimensions for sending to the printer. 

 Offsets  : Display the panel offsets for sending to the printer. 

 ...............  

 Screen  : Prints the screen. 

 

About 

 About  : Display information about software version etc. 

 Bug Report  : Creates a problem report file that can be e-mail to Armstrong-
White for problem support. 

Menus 


